Notice
While reasonable efforts were made to ensure that the information in this document was complete and accurate at the time of printing, Avaya Inc. can assume no liability for any errors. Changes and corrections to the information in this document might be incorporated in future releases.

Documentation disclaimer
Avaya Inc. is not responsible for any modifications, additions, or deletions to the original published version of this documentation unless such modifications, additions, or deletions were performed by Avaya. Customer and/or End User agree to indemnify and hold harmless Avaya, Avaya's agents, servants and employees against all claims, lawsuits, demands and judgments arising out of, or in connection with, subsequent modifications, additions or deletions to this documentation to the extent made by the Customer or End User.

Link disclaimer
Avaya Inc. is not responsible for the contents or reliability of any linked Web sites referenced elsewhere within this documentation, and Avaya does not necessarily endorse the products, services, or information described or offered within them. We cannot guarantee that these links work all the time and we have no control over the availability of the linked pages.

License
USE OR INSTALLATION OF THE PRODUCT INDICATES THE END USER'S ACCEPTANCE OF THE TERMS SET FORTH HEREIN AND THE GENERAL LICENSE TERMS AVAILABLE ON THE AVAYA WEB SITE http://support.avaya.com/Licenselicensing/"GENERAL LICENSE TERMS"). IF YOU DO NOT WISH TO BE BOUND BY THESE TERMS, YOU MUST RETURN THE PRODUCT(S) TO THE POINT OF PURCHASE WITHIN TEN (10) DAYS OF DELIVERY FOR A REFUND OR CREDIT.

Avaya grants End User a license within the scope of the license types described below. The applicable number of licenses and units of capacity for which the license is granted will be one (1), unless a different number of licenses or units of capacity is specified in the Documentation or other materials available to End User. "Designated Processor" means a single stand-alone computing device, "Server" means a Designated Processor that hosts a software application to be accessed by multiple users. "Software" means the computer programs in object code, originally licensed by Avaya and ultimately utilized by End User, whether as stand-alone Products or pre-installed on Hardware. "Hardware" means the standard hardware Products, originally sold by Avaya and ultimately utilized by End User.

License Type(s)
Designated System(s) License (DS). End User may install and use each copy of the Software on only one Designated Processor, unless a different number of Designated Processors is indicated in the Documentation or other materials available to End User. Avaya may require the Designated Processor(s) be identified by type, serial number, feature key, location or other specific designation, or to be provided by End User to Avaya through electronic means established by Avaya specifically for this purpose.

Concurrency User License (CU). End User may install and use the Software on multiple Designated Processors or one or more Servers, so long as only the licensed number of Units are accessing and using the Software at any given time. A "Unit" means the unit on which Avaya, at its sole discretion, bases the pricing of its licenses and can be, without limitation, an agent, port or user, an e-mail or voice mail account in the name of a person or corporate function (e.g., webmaster or helpdesk), or a directory entry in the administrative database utilized by the Product that permits one or more users to interface with the Software. Units may be linked to a specific, identified Server.

Database License (DL). Customer may install and use each copy of the Software on one Server or on multiple Servers provided that each of the Servers on which the Software is installed communicate with no more than a single instance of the same database.

CPU License (CP). End User may install and use each copy of the Software on a number of Servers up to the number indicated by Avaya provided that the performance capacity of the Server(s) does not exceed the performance capacity specified for the Software. End User may not re-install or operate the Software on Server(s) with a larger performance capacity without Avaya's prior consent and payment of an upgrade fee.

Named User License (NU). Customer may: (i) install and use the Software on a single Designated Processor or Server per authorized Named User (defined below); or (ii) install and use the Software on a Server so long as only authorized Named Users access and use the Software. "Named User," means a user or device that has been expressly authorized by Avaya to access and use the Software. At Avaya's sole discretion, a "Named User" may be, without limitation, designated by name, corporate function (e.g., webmaster or helpdesk), an e-mail or voice mail account in the name of a person or corporate function, or a directory entry in the administrative database utilized by the Product that permits one user to interface with the Product.

Shrinkwrap License (SR). With respect to Software that contains elements provided by third party suppliers, End user may install and use the Software in accordance with the terms and conditions of the "shrinkwrap" or "clickwrap" license accompanying the Software ("Shrinkwrap License"). The text of the Shrinkwrap License will be available from Avaya upon End User's request (see "Copyright" below for more information).

Copyright
Except where expressly stated otherwise, the Product is protected by copyright and other laws respecting proprietary rights. Unauthorized reproduction, transfer, and or use can be a criminal, as well as a civil, offense under the applicable law.

Third-party Components
Certain software programs or portions thereof included in the Product may contain software distributed under third party agreements ("Third Party Components"), which may contain terms that expand or limit rights to use certain portions of the Product ("Third Party Terms"). Information identifying Third Party Components and the Third Party Terms that apply to them is available on the Avaya Support Web site: http://support.avaya.com/ThirdPartyLicense/

Preventing Toll Fraud
"Toll fraud" is the unauthorized use of your telecommunications system by an unauthorized party (for example, a person who is not a corporate employee, agent, subcontractor, or is not working on your company's behalf). Be aware that there might be a risk of toll fraud associated with your system and that, if toll fraud occurs, it can result in substantial additional charges for your telecommunications services.

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need technical assistance or support, call Technical Service Center Toll Fraud Intervention Hotline at +1-800-643-2353 for the United States and Canada. For additional support telephone numbers, see the Avaya Support Web site: http://www.avaya.com/support

Providing Telecommunications Security
Telecommunications security (of voice, data, and/or video communications) is the prevention of any type of intrusion to (that is, either unauthorized or malicious access to or use of) your company's telecommunications equipment by some party.

Your company's "telecommunications equipment" includes both this Avaya product and any other voice/data/video equipment that can be accessed by this Avaya product (that is, "networked equipment"). An "outside party" is anyone who is not a corporate employee, agent, subcontractor, or is not working on your company's behalf. Whereas, a "malicious party" is anyone (including someone who might be otherwise authorized) who accesses your telecommunications equipment with either malicious or mischievous intent.

Such intrusions might be either to/through synchronous (time-multiplexed and/or circuit-based), or asynchronous (character-, message-, or packet-based) equipment, or interfaces for reasons of:

- Utilization (of capabilities special to the accessed equipment)
- Theft (such as, of intellectual property, financial assets, or toll facility access)
- Eavesdropping (privacy invasions to humans)
- Mischief (troubling, but apparently innocuous, tampering)
- Harm (such as harmful tampering, data loss or alteration, regardless of motive or intent)

Be aware that there might be a risk of unauthorized intrusions associated with your system and/or its networked equipment. Also realize that, if such an intrusion should occur, it might result in a variety of losses to your company (including but not limited to, human/data privacy, intellectual property, material assets, financial resources, labor costs, and/or legal costs).
Responsibility for Your Company’s Telecommunications Security

The final responsibility for securing both this system and its networked equipment rests with you — Avaya’s customer system administrator, your telecommunications peers, and your managers. Base the fulfillment of your responsibility on acquired knowledge and resources from a variety of sources including but not limited to:

- Installation documents
- System administration documents
- Security documents
- Hardware/software-based security tools
- Shared information between you and your peers
- Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your peers should carefully program and configure:

- Your Avaya-provided telecommunications systems and their interfaces
- Your Avaya-provided software applications, as well as their underlying hardware/software platforms and interfaces
- Any other equipment networked to your Avaya products

TCP/IP Facilities

Customers might experience differences in product performance, reliability and security depending upon network configurations/design and topologies, even when the product performs as warranted.

Standards Compliance

Avaya Inc. is not responsible for any radio or television interference caused by unauthorized modifications of this equipment or the substitution or attachment of connecting cables and equipment other than those specified by Avaya Inc. The correction of interference caused by such unauthorized modifications, substitution or attachment is the responsibility of the user. Pursuant to Part 15 of the Federal Communications Commission (FCC) Rules, the user is cautioned that changes or modifications not expressly approved by Avaya Inc. might void the user’s authority to operate this equipment.

Federal Communications Commission Statement

Part 15:

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Canadian Department of Communications (DOC) Interference Information

This Class A digital apparatus complies with Canadian ICES-003. Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

This equipment meets the applicable Industry Canada Terminal Equipment Technical Specifications. This is confirmed by the registration number. The abbreviation, IC, before the registration number signifies that registration was performed based on a Declaration of Conformity indicating that Industry Canada technical specifications were met. It does not imply that Industry Canada approved the equipment.

European Union Declarations of Conformity


Copies of these Declarations of Conformity (DoCs) can be obtained by contacting your local sales representative and are available on the Avaya Support Web site:

http://www.avaya.com/support

Trademarks

Aria, AUDIX, Avaya, DEFINITY, INTUITY, and Serenade are registered trademarks of Avaya Inc. COMPAS and Mailbox Manager are trademarks of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.

Document ordering information:
Avaya Publications Center
For the most current versions of documentation, go to the Avaya Support Web site:
http://www.avaya.com/support

Avaya support
Avaya provides a telephone number for you to use to report problems or to ask questions about your product. The support telephone number is 1-800-242-2121 in the United States. For additional support telephone numbers, see the Avaya Support Web site:
http://www.avaya.com/support

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.
## Contents

**Preface**  
- Overview .......................................................... 7  
- Audience .......................................................... 7  
- Summary of chapters ........................................... 7  
- Modular Messaging Documentation .......................... 8  
- Conventions ....................................................... 8  

**Chapter 1: Introduction to Modular Messaging Notes Client** ......................................................... 9  
- Overview .......................................................... 9  
- What is Avaya Modular Messaging? ......................... 9  
- What does Avaya Modular Messaging Notes Client do? 10  
- Using Modular Messaging Notes Client .................. 10  
- Inbox Folder ....................................................... 11  
- Voice Memo Form ................................................ 11  
- Opening the Voice Memo Form ............................ 12  
- Using the Voice Memo Form ............................... 12  
- Subscriber Options ............................................. 13  

**Chapter 2: Installing Modular Messaging Notes Client** ................................................................. 15  
- Introduction ....................................................... 15  
- Before you begin ................................................. 15  
- Hardware and software requirements ..................... 16  
- Installing the Modular Messaging Notes Client .......... 17  
- Upgrading the Modular Messaging Notes Client .......... 18  
- Uninstalling the Modular Messaging Notes Client ...... 18  

**Chapter 3: Configuring Modular Messaging Notes Client** ............................................................. 19  
- Introduction ....................................................... 19  
- Prerequisites ....................................................... 19  
- Initializing Subscriber Options ............................. 20  
- Creating the Modular Messaging Database ................. 21  
- Upgrading the Modular Messaging Database Design .... 22  

**Chapter 4: Modular Messaging Database** ....................................................................................... 23  
- Getting started ...................................................... 23  
- Inbox folder ......................................................... 23  
- Opening a message ............................................... 23  
- Columns ............................................................... 24  
- Action Bar ............................................................ 24  
- Other folders and views ....................................... 25  
- Drafts view .......................................................... 25  
- Sent view ............................................................. 26  
- Trash folder .......................................................... 26  
- All Documents view ............................................. 27  
- Folders (Local) ...................................................... 27  
- Preferences .......................................................... 27
### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscriber Options</td>
<td>28</td>
</tr>
<tr>
<td><strong>Chapter 5: Modular Messaging Voice Memo Form</strong></td>
<td>29</td>
</tr>
<tr>
<td>Getting started</td>
<td>29</td>
</tr>
<tr>
<td>Composing and sending voice messages</td>
<td>30</td>
</tr>
<tr>
<td>Creating new voice messages</td>
<td>31</td>
</tr>
<tr>
<td>Recording voice messages</td>
<td>31</td>
</tr>
<tr>
<td>Adding text comments to voice messages</td>
<td>32</td>
</tr>
<tr>
<td>Adding attachments to voice messages</td>
<td>33</td>
</tr>
<tr>
<td>Sending voice messages</td>
<td>33</td>
</tr>
<tr>
<td>Addressing voice messages</td>
<td>34</td>
</tr>
<tr>
<td>Assigning delivery options</td>
<td>35</td>
</tr>
<tr>
<td>Sending a voice message</td>
<td>36</td>
</tr>
<tr>
<td>Saving voice messages</td>
<td>36</td>
</tr>
<tr>
<td><strong>Working with incoming voice messages</strong></td>
<td>38</td>
</tr>
<tr>
<td>Opening voice messages from the Inbox</td>
<td>38</td>
</tr>
<tr>
<td>Reviewing voice messages</td>
<td>39</td>
</tr>
<tr>
<td>Listening to voice messages</td>
<td>39</td>
</tr>
<tr>
<td>Navigating through voice messages</td>
<td>40</td>
</tr>
<tr>
<td>Viewing text messages, fax messages and attachments</td>
<td>41</td>
</tr>
<tr>
<td>Replying to voice messages</td>
<td>43</td>
</tr>
<tr>
<td>Forwarding voice messages</td>
<td>44</td>
</tr>
<tr>
<td>Managing messages</td>
<td>45</td>
</tr>
<tr>
<td>Saving voice messages</td>
<td>45</td>
</tr>
<tr>
<td>Deleting voice messages</td>
<td>46</td>
</tr>
<tr>
<td>Editing Voice Messages</td>
<td>46</td>
</tr>
<tr>
<td>Copying or moving voice messages</td>
<td>47</td>
</tr>
<tr>
<td>Synchronizing voice messages</td>
<td>47</td>
</tr>
<tr>
<td><strong>Reference Information</strong></td>
<td>49</td>
</tr>
<tr>
<td>Modular Messaging and Fax</td>
<td>49</td>
</tr>
<tr>
<td>Sending a Fax message</td>
<td>49</td>
</tr>
<tr>
<td>Viewing and Printing a fax message</td>
<td>50</td>
</tr>
<tr>
<td>Managing fax messages for TUI access</td>
<td>50</td>
</tr>
<tr>
<td><strong>Glossary</strong></td>
<td>51</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>53</td>
</tr>
</tbody>
</table>
Preface

Overview

This guide describes how to set up the Avaya Modular Messaging Notes Client from your desktop. It explains how to use the Avaya Modular Messaging Notes Client and customize it to suit your environment.

Audience

This guide is intended for users and administrators of the client software for Avaya Modular Messaging Notes Client.

Summary of chapters

This guide includes the following chapters:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, <strong>Introduction to Modular Messaging Notes Client</strong></td>
<td>Introduces you to the various components of the Avaya Modular Messaging Notes Client software.</td>
</tr>
<tr>
<td>Chapter 2, <strong>Installing Modular Messaging Notes Client</strong></td>
<td>Provides instructions on installing the client software.</td>
</tr>
<tr>
<td>Chapter 3, <strong>Configuring Modular Messaging Notes Client</strong></td>
<td>Provides instructions on the configuration and preferences for the Avaya Modular Messaging Notes Client software.</td>
</tr>
<tr>
<td>Chapter 4, <strong>Modular Messaging Database</strong></td>
<td>Describes the Modular Messaging database folders, views, and operation.</td>
</tr>
<tr>
<td>Chapter 5, <strong>Modular Messaging Voice Memo Form</strong></td>
<td>Describes how to review, compose, address, and send voice messages using the Voice Memo Form.</td>
</tr>
</tbody>
</table>
Module Messaging Documentation

For more information about Modular Messaging, see the following documentation available on the Avaya Support Site at http://www.avaya.com/support.

- **Avaya Modular Messaging Subscriber Options User Guide**
  Provides information on using Avaya Modular Messaging Subscriber Options to record greetings and customize the call and message handling features.

- **Avaya Modular Messaging Telephone User Interface Guide**
  Provides information on how to use telephone user interfaces (TUls) of Modular Messaging.

- **AUDIX Telephone User Interface for Avaya Modular Messaging Quick Reference Guide**
  Provides at-a-glance information on how to use Avaya Modular Messaging through an AUDIX-based telephone user interface.

- **Aria Telephone User Interface for Avaya Modular Messaging Quick Reference Guide**
  Provides at-a-glance information on how to use Avaya Modular Messaging through an Aria-based telephone user interface.

- **Serenade Telephone User Interface for Avaya Modular Messaging Quick Reference Guide**
  Provides at-a-glance information on how to use Avaya Modular Messaging through a Serenade-based telephone user interface.

Conventions

The following conventions are used in this guide:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Capitals</td>
<td>Names of applications, programs, menu dialogs appear in Initial Capitals. For example, the Change Setup Language</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Document titles appear in italics. For example, <em>Avaya Modular Messaging Access to a Subscriber Mailbox</em></td>
</tr>
<tr>
<td><strong>bold</strong></td>
<td>Field names, field entries, tab names, button names, and menu items appear in bold. For example, Click <strong>Next</strong> to continue with the installation.</td>
</tr>
</tbody>
</table>
Chapter 1: Introduction to Modular Messaging Notes Client

Overview

This guide describes how to use the Avaya Modular Messaging Notes Client software. Avaya Modular Messaging Notes Client consists of the following components:

- Modular Messaging database
- Modular Messaging Subscriber Options

For information about:

- Installing and setting up the Modular Messaging Notes Client, see Chapter 2, Installing Modular Messaging Notes Client.
- Configuring the Modular Messaging Notes Client, see Chapter 3, Configuring Modular Messaging Notes Client.
- Using the Modular Messaging database, see Chapter 4, Modular Messaging Database.
- Using the Modular Messaging Voice Memo Form, see Chapter 5, Modular Messaging Voice Memo Form.
- Modular Messaging Subscriber Options, see the Avaya Modular Messaging Subscriber Options User Guide.
- Using the Avaya Modular Messaging telephone user interfaces, refer to the documents listed in Modular Messaging Documentation on page 8.

What is Avaya Modular Messaging?

Avaya Modular Messaging treats voice and fax messages just like e-mail messages. You can send, retrieve, reply to, and forward any message. Message headers indicate the type of message (voice, e-mail, or fax), the sender name, the telephone number of the sender, and the message subject, allowing you to quickly and easily select a message and act on it.

The Avaya Modular Messaging voice mailbox has its own separate e-mail address. Depending on the configuration, your voice and fax messages are stored directly in your e-mail mailbox or in a separate mailbox. If you have separate mailboxes for your e-mail and voice mails, you can receive e-mail messages into your regular mailbox or into your Modular Messaging mailbox.
Avaya Modular Messaging provides telephone access to messages. When you are away from the office, you can dial into your mailbox through the TUI (Telephone User Interface) to check your messages. You can listen to your voice and e-mail messages. The Modular Messaging text-to-speech (TTS) feature converts e-mail messages and the subject line of fax messages to voice. This allows you to listen to them as conveniently as you can listen to voice messages.

The Modular Messaging TUI also enables you to print your e-mail and fax messages by sending them to a nearby fax machine.

What does Avaya Modular Messaging Notes Client do?

Avaya Modular Messaging Notes Client integrates with your Lotus Notes client program and allows you to send, forward, reply, and listen to voice and e-mail messages from Lotus Notes and by using the telephone.

You can use the Modular Messaging Notes Client from your computer to:

- Send, forward, reply, and listen to voice and e-mail messages.
- Add comments to voice messages.
- View the subjects of fax messages and launch a fax viewer.
- Record and play back greetings.
- Create a fax using Windows Fax Print Driver and send it using Modular Messaging.

You can use Modular Messaging over the telephone to:

- Send, forward, reply, and listen to voice mails.
- Use TTS to play e-mail messages and fax subjects.
- Reply or add comments to an e-mail message using a voice message.
- Send e-mail and fax messages to a printer.

Using Modular Messaging Notes Client

You can implement Modular Messaging Notes Client as a Notes database to manage Modular Messaging messages. You can open this database in Lotus Notes, like any other database, using the following methods:

- Click a bookmark on the Bookmark Bar - You can add a bookmark for the Modular Messaging database directly to the Bookmark Bar, under the bookmark for Notes mail.
- Click a bookmark in a Bookmark Folder - You can add a bookmark for the Modular Messaging database within any bookmark folder on the Bookmark Bar.
Double-click the database icon on the Workspace - You can also add a database icon to the Notes workspace.

When you open the Modular Messaging database, the system displays the Inbox folder. All your new and saved messages found on the Modular Messaging server are listed.

Note:
You can refer to the Lotus Notes help database to learn about creating, deleting, and managing bookmarks and your workspace.

Inbox Folder

In the Inbox folder, new messages are shown as “Unread” (colored red) and saved messages are shown as “Read” (colored black). Information about each message is displayed in a series of columns including Who the message is from, the Date and Subject of the message, and icons to indicate the contents of the message.

The Inbox folder also displays an Action Bar at the top of the message list with a number of options including:

- New Memo
- Reply
- Reply to All
- Forward
- Delete
- Folder
- Synchronize
- Tools

When you open a message, the system displays the Voice Memo Form by double-clicking it within the Inbox or clicking once on the message and pressing the Return key.

Voice Memo Form

Avaya Modular Messaging uses a specially designed Voice Memo Form to easily record, send, and play back voice messages in Lotus Notes. The upper part of the Voice Memo Form is similar to a standard Notes memo form. The lower part of the form contains a voice player or recorder that includes controls similar to those found on a CD player or tape recorder. You can record and play back a message using these playback controls.
Opening the Voice Memo Form

You can open the Avaya Modular Messaging Voice Memo Form from your Notes client in any of the following ways:

- Click the New Memo Action Bar Button.
- OR
- Double-click a voice message displayed in the Inbox folder.

Using the Voice Memo Form

Use the Voice Memo Form to listen to voice messages and to record and send voice messages.

See Creating new voice messages on page 31 for information about using the Voice Memo Form to:

- Record your voice message using the telephone or multimedia.
- Attach comments to a voice message before or after you record it.
- Send your voice message and select the delivery options.
- Save a voice message in your Inbox or to a desired location.

See Working with incoming voice messages on page 38 for information about using the Voice Memo Form to:

- Listen to voice messages.
- Navigate through a voice message and parts of voice messages.
- Reply to voice messages with voice or e-mail.
- Forward voice messages and add voice or e-mail comments.

See Managing messages on page 45 for information about using the Voice Memo Form to:

- Save voice messages.
- Delete voice messages.
- Edit voice messages.
- Copy messages to Local Folders.
You can use Subscriber Options to change your mailbox settings for incoming call and message handling. Use the **Tools > Subscriber Options** Action Bar to access Subscriber Options from within the Modular Messaging database in Lotus Notes, or launch Subscriber Options from the Start Menu.

The following tabs are available within Subscriber Options:

- Assistant
- Greetings
- Telephone Access
- Fax Access
- Security
- Personal Distribution Lists
- Time Zone
- Message Ordering
- Other
- Language
- Media Setup

For information on Subscriber Options, see *Avaya Modular Messaging Subscriber Options User Guide*. 
**Chapter 2: Installing Modular Messaging Notes Client**

### Introduction

To install the Avaya Modular Messaging Notes Client software, you have to run the Setup program and specify where the files should be stored.

The Setup program installs the following components:

- Avaya Modular Messaging Notes database template
- Avaya Modular Messaging Online Help database
- Avaya Modular Messaging Software components
- Avaya Modular Messaging Subscriber Options

After installation, create your Modular Messaging database and specify your Modular Messaging account information.

You can also change other Modular Messaging configuration options available in Subscriber Options. For more information see *Avaya Modular Messaging Subscriber Options User Guide*.

### Before you begin

⚠️ **Important:**

Ensure that you first uninstall Avaya Modular Messaging Outlook Client before proceeding with this installation. Avaya does not support installing both the clients on a single computer.

For the voice player component of Avaya Modular Messaging Notes Client to work, you must do the following:

1. Click **Start > Settings > Control Panel**.
2. Double-click **Sounds and Multimedia**.
3. Click the **Audio** tab.
4. Under **Recording**, if you are using:
   - Windows 2000, check whether **Use only preferred devices** is selected.
   - Windows XP, check whether **Use only default devices** is selected.

   If it is selected, clear it.
Hardware and software requirements

This section lists the minimum client hardware and software requirements.

Operating system

- Microsoft Windows 2000 Professional (Service Pack 4)
- Microsoft Windows XP Professional (Service Pack 2)
- Microsoft Windows Vista

E-mail clients

- IBM Lotus Notes 6.5.6 or later
- IBM Lotus Notes 7.0.3 or later
- IBM Lotus Notes 8.0
- IBM Lotus Notes 8.5

Hardware

- Processor speed: As per standard Microsoft recommendations
- 128 MB of RAM
- 50 MB of free disk space (minimum)
Installing the Modular Messaging Notes Client

You can find the Avaya Modular Messaging Notes Client setup program in the Client subdirectory of the Modular Messaging directory on your network or on the CD-ROM where the Setup program is stored. For more information, contact your system administrator.

To install client software:

1. Open Windows Explorer.
2. Select the drive and the client subdirectory of the Modular Messaging directory on your network or the CD-ROM where the setup program is stored.
3. Double-click `Setup.exe`. The system displays the Welcome dialog box.
4. Click Next. The system displays the Customer Information dialog box. You can either select the default settings for User Name and Organization, or you can modify the settings.
5. Click Next. The system displays the Setup Type dialog box. You can select Complete or Custom setup.
   - Complete setup installs Subscriber Options with the Modular Messaging Notes Client component.
   - Custom setup enables you to install Subscriber Options without the Modular Messaging Notes Client component and/or change the destination folder.
6. Click Next. Based on how your administrator has configured the installation package the system can or cannot display the Administrative Options dialog box. If the system displays this dialog box, select the appropriate options. If you are not sure what options are appropriate, contact your system administrator.
7. Click Next. The system displays the Destination Folder dialog box. You can accept the default destination or modify the setting.
8. Click Next. The system displays the Ready to Install the Program dialog box.
9. Click Install to continue the installation process. The system displays several messages as it installs the software. When the installation process is complete, the system displays the InstallShield Wizard Completed dialog box.
10. Click Finish to complete the installation.

Before you use the client software, you must run Subscriber Options and configure the Avaya Modular Messaging database. For more information, See Chapter 3: Configuring Modular Messaging Notes Client on page 19.
Upgrading the Modular Messaging Notes Client

You can upgrade the Avaya Modular Messaging Notes Client by running the updated Setup.exe program and following the prompts. The setup program automatically detects that the client had been previously installed, and automatically upgrades the existing software. When the setup program is finished it is important that you proceed with Upgrading the Modular Messaging Database Design on page 22 to upgrade the design of your Modular Messaging database before you attempt to open the database.

Uninstalling the Modular Messaging Notes Client

You can permanently remove Avaya Modular Messaging Notes Client software from your computer.

To remove Modular Messaging Notes Client software:

1. Close Notes Client.
2. Open the Control Panel.
3. Double-click Add/Remove Programs. The system displays Add/Remove dialog box.
4. Select Avaya Modular Messaging Notes Client.
5. Click Remove.
6. Click Yes when asked if you want to remove the Modular Messaging Notes Client.

The system removes the Modular Messaging Notes Client software from your computer.

7. Restart your computer, if prompted.

To remove the Modular Messaging database:

1. Right click the Bookmark you created during the installation procedure and choose Database > Delete...
2. Click Yes when asked if you really want to delete this database.

⚠️ CAUTION:

The system deletes all your locally stored Modular Messaging messages when you delete the Modular Messaging database. This includes all messages stored in your Drafts, Sent, and Local message folders. All other messages are stored on the Modular Messaging Message Storage Server and will not be deleted.
Chapter 3: Configuring Modular Messaging Notes Client

Introduction

You need to set up and configure the Modular Messaging Subscriber Options and the Modular Messaging database before using the Avaya Modular Messaging Notes Client software. The Modular Messaging database is a Notes database that communicates with the Modular Messaging server to access your messages.

If you have an existing Modular Messaging database and have already performed an upgrade of the Modular Messaging Notes Client software as described in Upgrading the Modular Messaging Notes Client on page 18, please refer to Upgrading the Modular Messaging Database Design on page 22 for information on upgrading the design of your existing Modular Messaging database.

Setting up Subscriber Options and configuring the Modular Messaging database requires the following steps:

1. Initialize Subscriber Options and set your playback and recording settings.
2. Create the Modular Messaging database from the Modular Messaging template.
3. Open the database which causes the Preferences Dialog to be displayed.
4. Enter the Modular Messaging Message Storage Server (MSS) network name or IP address, your mailbox number and the password.
5. Create a Bookmark for the Modular Messaging database on your Bookmark bar.

Prerequisites

The following are prerequisites for configuring the Modular Messaging database:

**Avaya Modular Messaging Notes Client software**

- Must be installed as described in Installing the Modular Messaging Notes Client on page 17.

**Avaya Modular Messaging Message Storage Server (MSS)**

- Network name or IP address
Configuring Modular Messaging Notes Client

- User mailbox number
- User password

**Avaya Modular Messaging Message Application Server (MAS)**

- Server network name or IP address
- User mailbox number
- User password

---

**Initializing Subscriber Options**

Before you can use the Modular Messaging Notes Client software you must initialize Subscriber Options.

**To initialize Subscriber Options:**

1. Click **Start > All Programs > Avaya Modular Messaging > Subscriber Options** to run the Subscriber Options program. The User Login dialog box displays.

2. Enter the following information and click **OK** to log in to the MAS:
   - Your Mailbox number
   - Your Password
   - The network name or IP address of your MAS. Contact your system administrator for server name or IP address.

   You can click the **Remember password** check box if you want the system to remember your password and use it the next time you run Subscriber Options.

   The Modular Messaging User Properties dialog box is displayed.

3. Click the **Media Setup** tab to display the options for playback and recording. Select one of the following options as the default setting for composing or reviewing messages:
   - **Telephone** will cause the MAS to call you when recording or playing a message.
   - **Multimedia** will cause the local sound card, microphone and speakers to be used when recording or playing messages.

4. Click **OK** at the bottom of the dialog box to save these settings and close Subscriber Options.

For information on Subscriber Options and these features, see *Avaya Modular Messaging Subscriber Options User Guide*.

Proceed with the following section to create your Modular Messaging database.
Creating the Modular Messaging Database

After you install the Modular Messaging Notes Client create a new Modular Messaging database. You only have to create a new Modular Messaging database once.

To create the Modular Messaging Database:

1. Open Lotus Notes. Click **File > Database > New...**
   - The New database dialog box is displayed.

2. In the section of the dialog labeled Specify New Database Name and Location:
   - Leave the **Server** field set to **Local**.
   - In the **Title** field enter **Avaya Modular Messaging** or some similar name to identify this database.
   - Leave the **File name** field as shown, or enter another valid file name.

3. In the section of the dialog labeled Specify Template for New Database:
   - Leave the **Server** field set to **Local**.
   - Select the **Modular Messaging Notes Client** template in the Template list.

4. Click **OK**.

   - The database is created and the Preferences dialog box displays.

5. Enter the following information:
   - Enter the MSS network name or IP Address provided by your system administrator in the Server Information section.
   - Enter the **Mailbox number** and **Password** for your account in the Logon Information section.

6. Click **OK**.

   - **Note:** One or more Lotus Notes Execution Control List (ECL) warnings may display when the database is first opened. These warnings indicate the software is attempting an operation that requires your approval. Click on **Start trusting the signer to execute this action** to allow the software operation to complete. An ECL warning may be displayed for each different operation attempted by the software, but after you have approved each operation (by clicking the "Start trusting the signer to execute this action" option) you will not receive the same warning again for this database.

The Inbox for the database displays showing all new and saved messages. You can use the Modular Messaging database to review your voice messages. To find out more about using the
Upgrading the Modular Messaging Database Design

If you have an existing Modular Messaging database, and have just upgraded the Modular Messaging Notes Client software as described in Upgrading the Modular Messaging Notes Client on page 18, you must refresh the design of your existing Modular Messaging database. This upgrade procedure must be performed before you attempt to open the Modular Messaging database after upgrading the Modular Messaging Notes Client software.

To refresh the design of your Modular Messaging database:

1. Right-click your Modular Messaging database bookmark or icon, and select Database > Refresh Design... from the menu.
2. Select Local when prompted with the With Design from Server dialog.
3. Click Yes on the next dialog displayed to confirm the refresh operation.

Lotus Notes refreshs the design of your Modular Messaging database, and when the refreshes process is complete you can open the database and begin reviewing messages.

If you have any problems with the refresh process, you can choose to replace the design of your existing Modular Messaging database. It may be necessary to replace the design if the original database was not enabled to inherit its design from a template.

To replace the design of your existing Modular Messaging database:

1. Right-click on your Modular Messaging database bookmark or icon, and select Database > Replace Design... from the menu.
2. Select Local for the Template server, and locate the Modular Messaging Notes Client template in the list of templates. Make sure the Inherit future design changes option is checked.
3. Click the Replace button to replace the design.
4. Click Yes on the next dialog to confirm the replace operation.

Lotus Notes replaces the design of your Modular Messaging database, and when the replace process is complete you can open the database and begin reviewing messages.
Getting started

Avaya Modular Messaging Notes Client uses a Notes database to retrieve and store messages from the Modular Messaging Message Storage Server (MSS). Although the Modular Messaging database is similar to your Notes mail database, the Modular Messaging database is used to manage your Modular Messaging voice, fax and text messages, while your Notes mail database is used to manage your Domino messages.

The Modular Messaging database includes many of the same features as the standard Notes mail database including folders and views. It also includes some new features such as a Voice Memo Form and a Voice Player and Recorder.

This chapter discusses the Modular Messaging database including the folders, views and preferences, while the next chapter discusses the Voice Memo Form and includes procedures for creating new voice, fax and text messages, and replying to and forwarding messages.

Inbox folder

When you open your Modular Messaging database, the system displays Inbox folder. The Inbox folder contains all your Modular Messaging messages stored within the New and Saved folders on the MSS. New messages are shown in red and represent messages which have not been reviewed (unread). Saved messages are displayed in black, and represent previously reviewed messages (read).

Opening a message

You can open any message in the Inbox by double-clicking the message in the list, or by single-clicking the message and pressing Return. You can review the message by playing the voice message component, and by viewing the fax and reading the text components. See Working with incoming voice messages on page 38 for more information about using the Voice Memo Form to review messages.
Columns

The Inbox folder contains several columns of information about the messages.

The messages in the folder are normally sorted by Date and Time, but the folder can also be sorted by other column information simply by clicking the column header for most columns.

You can arrange the columns by dragging and dropping the column headers to new positions.

The following columns are displayed in the Inbox:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Sortable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Displays icons indicating the type of message including Urgent, Private and Broadcast messages.</td>
<td>No</td>
</tr>
<tr>
<td>Who</td>
<td>Displays the name of the person who sent the message.</td>
<td>Yes</td>
</tr>
<tr>
<td>Reply/Forward</td>
<td>Displays icons depicting whether the message has been replied to or forwarded.</td>
<td>Yes</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the date the message was received.</td>
<td>Yes - default</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the time the message was received in the local timezone.</td>
<td>No</td>
</tr>
<tr>
<td>Size</td>
<td>Displays the size of the message in bytes.</td>
<td>Yes</td>
</tr>
<tr>
<td>Content</td>
<td>Displays icons indicating the content of the message. If voice is available a telephone icon is displayed. Other icons include a fax icon and a file attachment icon.</td>
<td>Yes</td>
</tr>
<tr>
<td>Subject</td>
<td>Displays the subject of the message. The length of voice messages in seconds is also displayed.</td>
<td>No</td>
</tr>
</tbody>
</table>

Action Bar

The Inbox folder includes an Action Bar with several buttons including:

- **New Memo** - creates a new message.
- **Reply** - creates a reply to the selected message. Options are available to reply with, or without history.
- **Reply to All** - creates a reply to the selected message and includes all other recipients. Options are available to reply with, or without history.
- **Forward** - creates a forwarded message, including the selected message, that you can send to another user.
Other folders and views

The Modular Messaging database includes several other folders and views to help you manage your messages.

Drafts view

When you save a new message using the Save As Draft Action Bar button, the system displays message in the Drafts view. This allows you to reopen the draft message and complete it before sending it out.

The Drafts view looks similar to the Inbox folder and includes the same columns and Action Bar options.

Note:

Messages saved in the Drafts view are only stored within the local Modular Messaging database. This means that they may not be backed up by your company’s backup system and are not available from any other Notes desktop.
Sent view

When you send a message you can also choose to save the message. These saved messages are displayed in the Sent view. You can open the Sent view to review messages you sent, and even resend the message to the same or other recipients.

The Sent view looks similar to the Inbox folder and includes the same columns and Action Bar options.

Note:
Messages saved in the Sent view are only stored within the local Modular Messaging database. This means that they may not be backed up by your company’s backup system and are not available from any other Notes desktop.

Trash folder

When you delete a message from the Inbox it is moved to the Trash folder on both the MSS and within the local Modular Messaging database. The message remains in the Trash folder until it is removed from the MSS (based on your account settings), or until you delete it from your Trash folder.

When you delete a message from the Drafts or Sent view it is also moved to the Trash folder and is stored there until you delete it from the Trash folder.

The Trash folder includes the same columns as the Inbox folder, but it has different Action Bar buttons including:

- **Restore** - moves the selected message from the Trash folder to the folder from which it was originally deleted.
- **Restore All** - moves all messages in the Trash folder to their original folders.
- **Delete Selected Item** - deletes the selected message from the Trash. This also removes the message from the Trash folder on the MSS, if it exists on the MSS.
- **Empty Trash** - deletes all messages from the Trash folder.

All Documents view

The All Documents view displays all of the messages within the Modular Messaging database. This view helps you look for messages that may be stored in any folder.

The All Messaging view is similar to the Inbox folder including the same columns and Action Bar options.
Folders (Local)

Folders are useful for organizing your messages in a way meaningful to you. You can show the same message in one folder or in as many folders as you want.

Folders you create are similar to the Inbox folder including the same columns and Action Bar options.

Before you move or add a message, note these distinctions:

- When you move a message to a folder, Notes shows the message in the target folder instead of in the current folder. You are not really "moving" the message at all - you are telling Notes which folder should show the message.
- When you add a message to a folder, Notes shows the message in both the current folder and the target folder.

⚠️ CAUTION:

There is only one message. If you delete a message in any folder or view, it disappears from all other folders and views.

If you move a message from your Inbox to a local folder (when allowed by your Administrator) the message is removed from the MSS, and will not be available for review from the telephone.

Preferences

You can access the Preferences dialog box by clicking the Tools > Preferences... Action Bar button from any folder or view, except the Trash folder. The Preferences dialog box contains the MSS Server name, your mailbox number and your password. This information was entered when the database was first setup as discussed in Creating the Modular Messaging Database on page 21.

In most cases the server name and mailbox number never need to be changed. Your password may need to be updated periodically depending on your account settings within the MSS.

The Preferences dialog box also contains Notification settings. These settings allow you to configure what happens upon receipt of a new message. Options include the ability to display a visual pop-up dialog and/or to play a system sound when new mail arrives. The sound that is played can be selected from a drop down list of available "tunes".
Subscriber Options

You can use Subscriber Options to change your mailbox settings for incoming calls and message handling. Subscriber Options is installed as a separate application and can be started from the Start Menu within Windows by clicking:

Start > All Programs > Avaya Modular Messaging > Subscriber Options

You can also access Subscriber Options from the Inbox folder and other views by clicking:

Tools > Subscriber Options...

For information on Subscriber Options, see Avaya Modular Messaging Subscriber Options User Guide.
Chapter 5: Modular Messaging Voice Memo Form

Getting started

Avaya Modular Messaging Notes Client uses a specially designed Voice Memo Form to record, send, and play back voice messages within your Modular Messaging database. The upper part of the Voice Memo Form is similar to a standard Memo form (with the usual To, cc and bcc fields). Below this header information is a voice player/recorder that has controls similar to a CD player or a tape recorder (with Play, Stop, Forward, and Reverse options). You can record and play back a message using these playback controls.

Below the player/recorder is the body of the message similar to the body found in the standard Notes Memo Form. The body can include text information as well as file attachments.

This chapter covers the following topics:

Composing and sending voice messages
To create a new message, including voice, text and file attachments, see Composing and sending voice messages on page 30.

Working with incoming voice messages
To review incoming messages, including playing back voice messages, and viewing text, fax and other attachments, see Working with incoming voice messages on page 38.

Replying to voice messages
To reply to a voice message see Replying to voice messages on page 43.

Forwarding voice messages
To forward a voice message see Forwarding voice messages on page 44.

Managing voice messages
To save, delete or synchronize voice messages or message content see Managing messages on page 45.
Composing and sending voice messages

This section covers the following topics.

**Creating new voice messages**
Create a new voice message using an Action Bar button or from the Create menu.
See [Creating new voice messages](#) on page 31.

**Recording voice messages**
Record voice messages using the telephone or multimedia.
See [Recording voice messages](#) on page 31.

**Adding text comments to voice messages**
You can add a text comment to your voice message.
See [Adding text comments to voice messages](#) on page 32.

**Adding attachments to voice messages**
You can attach files to voice messages.
See [Adding attachments to voice messages](#) on page 33.

**Sending voice messages**
Address and select delivery options for your voice message, before sending the message.
See [Sending voice messages](#) on page 33.

**Saving voice message**
You can save partially composed voice messages in the Drafts folder.
See [Saving voice messages](#) on page 36.
Creating new voice messages

You can create new voice messages using one of the following methods:

- New Memo Action Bar Button. The New Memo Action Bar button is available in any view or folder (except the Trash folder), and in the Voice Memo Form itself.
- Memo from the Create menu. Click Create > Memo on the Notes menu to create a new Voice memo.

Recording voice messages

You can record a voice message by using the telephone or multimedia.

Note:
You can record new messages and retrieve voice messages using the telephone user interface (TUI) at any time. Recording messages using the Modular Messaging Notes Client provides an alternative to using the TUI, but does not replace it.

To record a voice message using the telephone

1. Create a new voice message.
   See Creating new voice messages on page 31. The voice recorder/player appears on the form below the message header.
2. Check the record mode icon to ensure it is set to Telephone mode. The icon should look like 📞 (telephone) and not 📻 (multimedia). If the icon is set to multimedia, right-click the icon and select Telephone.
3. Click the Record button 🎤.
4. When your telephone rings, pick up the receiver and record your message after the tone.
   Note:
   When using Modular Messaging from the desktop with the telephone, the system automatically disconnects you if you exceed the time limit set by your system administrator. To reconnect, hang up the telephone and click Record 🎤 again.
5. After you have finished recording, click the Stop button 🎤 or hang up the phone.

To record a voice message using multimedia

1. Create a new voice message.
   See Creating new voice messages on page 31. The voice recorder/player appears on the form below the message header.
2. Check the record mode icon to ensure it is set to **Multimedia** mode. The icon should look like 📞 (multimedia) and not 📞 (telephone). If the icon is set to telephone, right-click the icon and select **Multimedia**.

3. Click the **Record** button 🎤.

4. Record your message by speaking into the computer microphone.

5. After you have finished recording, click the **Stop** button ▶️.

   **Note:**
   - If you want to interrupt your recording, click the **Pause** button ✿.

**To review your recording**

1. Click the **Play** button ⏯️. Use the playback controls ⏪ ⏯️ to navigate through the message.

   **Note:**
   - If you recorded in Multimedia mode and you do not hear your voice message play back properly, there could be a problem with your microphone or mixer controls. Check to ensure that your microphone is plugged in properly, enabled and adjusted for adequate volume using the Windows mixer application.

   **⚠️ CAUTION:**
   - Be careful when adjusting the mixer controls, as enabling your microphone in playback mode can create very loud feedback, causing damage to your speakers and/or your ears.

2. If you want to continue recording, go to the end of the message and click the **Record** button 🎤.

   **Note:**
   - If you close the Voice Memo Form before sending the message you are prompted to save the message. See **Saving voice messages** on page 36 for more information.

---

### Adding text comments to voice messages

You can add text comments to a voice message before or after you record a message. For example, you might want to add a note about the content of the voice message. Text comments form part of the message text and are visible to recipients.

**To add text comments to a voice message**

1. Place the mouse cursor into the Body section of the Voice Memo Form. The Body is the white area below the player/recorder. Be sure to click the mouse to place the text cursor into the Body field.
2. Type your comments into the Body field.

**Note:**
Although the Body field is a Notes rich text field, any formatting you add to the text is lost when the message is sent because the MSS does not support Notes rich text format.

---

**Adding attachments to voice messages**

You can add attachments to your voice message before or after you record a message or add text comments.

**To add attachments to a voice message**

1. Place the mouse cursor into the Body section of the Voice Memo Form. The Body is the white area below the player/recorder. Be sure to click the mouse to place the text cursor into the Body field.
2. Click **File > Attach...** from the Notes menu to display the Create Attachment(s) dialog box.
3. Navigate to the folder where the file attachment is stored, and select the file. Alternatively you can attach the files by dragging and dropping the file.
4. Click **Create** to attach the file.

---

**Sending voice messages**

This section covers the following topics:

**Addressing voice messages**

Address a voice message you have recorded to other Modular Messaging subscribers, or other e-mail users.

See [Addressing voice messages](#) on page 34.

**Assigning delivery options**

You can assign delivery settings to your voice message, such as marking a message as Private or Urgent.

See [Assigning delivery options](#) on page 35.

**Sending a voice message**

Send a voice message you have composed.

See [Sending a voice message](#) on page 36.
Addressing voice messages

You can address a voice message before or after you record a voice message, or add text or attachments to the message. Ensure that you address the message before you send it.

To address a voice message manually

Choose one or more of the following options:

- Type the Modular Messaging or Lotus Notes e-mail address of the intended recipient in the **To** field of the Voice Memo Form.
- Type the first or last name, or the mailbox number of the desired Modular Messaging e-mail address in the **To** field and press **F9** or press **Tab** to proceed to the next field.

  The system resolves this partial entry and updates the **To** field with the complete Modular Messaging address for the user. If the system finds more than one match in the Modular Messaging directory, it displays a list of Modular Messaging e-mail addresses. Select the desired e-mail address from the list. If you type a numeric value, the system searches for the mailbox number you entered, and adds the complete Modular Messaging address to the **To** field.

  **Note:**
  
  The Modular Messaging system can display only the first 100 entries that match your search criteria. If you cannot find the intended recipient in the list provided, try using the last name or the mailbox number.

- Type the list name, or the list number of a valid Personal Distribution List. Personal Distribution Lists can be created and managed either by using the TUI, or the Subscriber Options application. You can also create and manage Personal Distribution Lists using Web Subscriber Options.

  **Note:**
  
  You can also address a message by typing the names of recipients into the **cc** and **bcc** fields.

  **Note:**
  
  You can add multiple addresses to any of these fields, separated by a comma (no extra space is needed), and the system resolves each address individually. For example when you enter 35026,barry.levine@mss.avaya.com, the system resolves each address separately.

To select addresses from an address book

You can use either the Modular Messaging Select Addresses dialog box or the Lotus Notes Select Addresses dialog box.

To use the Avaya Modular Messaging Select Addresses dialog box open a new memo and choose one of the following options:

- Click on the 'To' link
Composing and sending voice messages

- Click the **Address\Avaya Modular Messaging**... Action Bar button.

To use the Lotus Notes Select Addresses dialog box:

- Open a new memo and click the **Address\Lotus Notes**... Action Bar button.

Addresses selected from either Select Addresses dialog box populates the appropriate fields in the new voice memo when the dialog is closed.

**Note:**

When using the Avaya Modular Messaging Select Addresses dialog the system can display only the first 100 entries that match your search criteria. If you cannot find the intended recipient in the list provided you must refine your search.

### Assigning delivery options

#### Assigning priority levels

When sending a voice message, you can change the default setting of Normal priority and assign an urgent priority to this message. Changing the priority setting might cause the message to be delivered sooner if your mail server has been setup to prioritize messages when sending. In addition, recipients sees an exclamation mark in their Inbox next to each urgent message.

**To assign a priority level**

1. Click **Actions > Show Additional Mail Options** on the Notes menu or click on the down arrow icon at the right end of the Action Bar within a Voice Memo Form to display the message send options bar.

2. Check the box marked **Urgent** to set the priority for this message.

#### Setting the Private option

You can mark a message as Private before you send it, to inform the recipient that the information in the message should be handled as private information. Recipients are not allowed to forward or reply with history to a private message. In addition, users are not able to copy the message information to the clipboard.

**Note:**

Setting a message as Private does not guarantee that the message is not distributed without your permission as there are other methods available for users to copy the information in the message. It is intended to inform the recipient that the message should be treated as a Private message.

**To mark a message as Private**

1. Click **Actions > Show Additional Mail Options** on the Notes menu or click on the down arrow icon at the right end of the Action Bar within a Voice Memo Form to display the message send options bar.
2. Check the box marked **Private** to mark the message Private.

### Sending a voice message

When you have recorded your voice message, added text information and/or attachments, addressed the message and, where appropriate, set delivery options, you are ready to send the message.

**To send a voice message**

Choose one of the following options:

- Click the **Send** or the **Send and Save** Action Bar button to send the message, and optionally, to save the message to the Sent folder.
- Click **Actions > Send** or **Actions > Send and Save** from the Notes menu to send the message.

**Note:**

When sending a voice message to a Lotus Notes user or an internet mail recipient, the voice message is included in the message as a standard file attachment and the recipient is able to play the message using any standard wave file player.

If you use the **Send and Save** option, a copy of the message is saved in the Sent folder. You can open messages in the Sent folder anytime to edit the message and resend it. When you edit a saved message it is treated just like a new message and the same options are available.

**Note:**

Messages stored in the Sent folder are only stored in the local Modular Messaging database and are not stored on the Modular Messaging Message Storage Server.

### Saving voice messages

You can start composing a new voice message and then save it to finish and send at a later time.

**To save a voice message**

Choose one of the following options:

- Click the **Save as Draft** button in the Action Bar.
- Click **Actions > Save as Draft** from the Notes menu.

The message is saved in the Drafts folder. You can open the Drafts folder at a later time to find your message, complete it and send it.
Note:

Messages stored in the Drafts folder are only stored in the local Modular Messaging database and are not stored on the Modular Messaging Message Storage Server.
Working with incoming voice messages

The following topics are covered in this section.

Opening voice messages from the Inbox
You can select any message in the Inbox to review including New and Saved messages.
See Opening voice messages from the Inbox on page 38.

Listening to voice messages
You can listen to voice messages that you receive.
See Reviewing voice messages on page 39.

Viewing text messages, fax messages and attachments
You can view the text, fax and file attachments contained in messages you receive.
See Viewing text messages, fax messages and attachments on page 41.

Opening voice messages from the Inbox
When you open your Modular Messaging database, the system displays Inbox folder. All of the messages stored in the New and Saved folders on the Modular Messaging Message Storage Server are shown. New messages are shown as unread (colored red with a star to the left) and saved messages are shown as read (colored black).
See Inbox folder on page 23 for more information about the Inbox folder.

To open a message in your inbox
Choose one of the following options:
  ● Double-click the voice message.
  ● Select a voice message, and press Enter.

To close a message
Choose one of the following options:
  ● Press Esc.
  ● Click File > Close from the Notes menu.
Reviewing voice messages

You can review each voice message using the voice player/recorder built into the Voice Memo Form. Some messages may have more than one recording and the voice player allows you to navigate from one message to the next.

When you open a voice message from the Modular Messaging database Inbox the voice player automatically loads into the Voice Memo Form and loads any voice messages found in the message into the voice player. The Body of the message displays each voice message as an attachment with a yellow telephone icon 📞. You can copy and save these voice attachments. See Saving voice recordings, fax messages and other attachments to disk on page 45 for more information.

Note:

If your administrator has enabled "Media Streaming", the Body of the message displays each voice message using a gray telephone icon. You cannot copy, save or forward these messages.

Listening to voice messages

The Inbox displays a telephone icon next to each voice message. You can play the message using the telephone or the multimedia capability of your computer.

To listen to a voice message using the telephone

1. Open a voice message.
   
   See Opening voice messages from the Inbox on page 38. The system displays the voice player on the form below the message header.

2. Check the playback mode icon on the voice player to ensure it is set to Telephone mode. The icon looks like 📞 (telephone) and not 🎧 (multimedia). If the icon is set to multimedia, right-click the icon and select Telephone.

3. Click the Play button ⏯️. When your telephone rings, pick up the receiver to listen to the message.

   Note:

   When using Modular Messaging from the desktop with the telephone, the system automatically disconnects you if you exceed the time limit set by your system administrator. To reconnect, hangup the telephone and click Play ⏯️ again.

4. When you are finished playing the message hangup the telephone.

   Note:

   To stop the playback of the message, click the Stop button ■. Click the Play button ⏯️ to replay the message.
To listen to a voice message using multimedia

1. Open a voice message.
   See Opening voice messages from the Inbox on page 38. The voice player is displayed on
   the form below the message header.

2. Check the playback mode icon on the voice player to ensure it is set to Multimedia mode.
   The icon looks like 🎧 (multimedia) and not 📞 (telephone). If the icon is set to telephone,
   right-click the icon and select Multimedia.

3. Click the Play button 🎧.

4. The message begins playing over your speakers or headphones.

   Note:
   To stop the playback of the message, click the Stop button ■. Click the Play button 🎧 to replay the message.

   Note:
   If you are using Multimedia mode and you do not hear your voice message play
   back properly, there could be a problem with your speakers or mixer controls. Be
   sure your speakers or headphones are plugged in properly, and verify that your
   wave output is adjusted for adequate volume using the Windows mixer
   application.

Navigating through voice messages

You can navigate through a voice message by using the recording and playback controls on the
Voice Player.

To navigate through a recording

To skip forward, choose one of the following options:

● Click Skip Forward 🎧 on the Voice Player.

● Click to the right of the slider or drag it to the position in the voice message where you
  want the playback to start.

   Note:
   If you are playing back a message while it is downloading and you click on the
   slider or drag the slider to the right of the progress bar, the message playback
   pauses automatically. Click Play 🎧 to continue playback.

To skip back, choose one of the following options:

● Click Skip Back 🎧 on the Voice Player.

● Click to the left of the slider.
Navigating between message parts in multipart messages

When playing back a multipart message, Modular Messaging Notes Client plays back all message parts starting with the most current part. If you do not want to listen to all the parts of the message, you can navigate between them.

**Note:**

These commands are not available if a voice message consists of one part only.

**To navigate between message parts in multipart messages**

1. From the Player menu, choose one of the following options:
   - Click **Go to Previous Part** on the Voice Player to begin playing the previous message part. If you are already playing the first part, press this button to restart the playback of the first part.
     
     If you listen to a voice message containing the original part and a reply part, the first part is the reply.
   - Click **Go to Next Part** on the Voice Player to begin playing the next message part. If you are already listening to the last part, pressing this button stops the playback.
     
     If you listen to a voice message containing the original and a reply, the next message part is the original.

2. Use the slider to move between message parts. Message parts are marked by part dividers.

   You can navigate between messages parts while the message is playing, and when the playback is paused or stopped.

   **Note:**

   When downloading a voice message, you can use the slider to skip forward to a message part that has not been downloaded yet, in other words, to the right of the progress bar. Modular Messaging Notes Client then starts downloading this part and all subsequent parts before downloading the parts you have skipped.

---

**Viewing text messages, fax messages and attachments**

When you open a voice message from the Inbox, the voice player automatically loads into the Voice Memo Form, and loads any voice messages found in the message into the voice player. Text information and attachments display below the voice player.

**To view text messages**

You can read the text information in the Body field, and you can select the text and copy it to the clipboard as long as the message is not marked as Private. See [Assigning delivery options](#) on page 33 to mark a message as private.
To view fax messages
Fax messages are indicated with a fax icon in the Body of the message [fax]. You can view fax messages using one of the following options:

- Right-click and select **View** to use the built-in viewer in the Notes client.
- Right-click and select **Open** to launch the default viewer for fax messages. Fax messages have a file extension “.tif”. The system launches the default viewer for Windows and displays fax. Refer to the viewers help information for details on using the fax viewer.

To view attachments
File attachments other than voice and fax are indicated with an attachment icon [attachment] and the file name. The options available for viewing and opening the attachment depend on the type of attachment. Managing attachments in Modular Messaging Notes Client is the same as managing attachments in your Notes mail.

To manage attachments choose one of the following options:

- If Notes includes a built-in viewer for the attachment you can right-click the attachment and select **View**.
- You can launch the attachment using the application associated with the attachment by right clicking the attachment and selecting **Open**.
- You can double-click the attachment to view the attachment property box, which provides some details about the attachment and provides several options for managing the attachment.
Replying to voice messages

You can reply to messages you receive in your Modular Messaging database. Your reply can also include the original message in the Body of the new message, if you choose to reply with history. In addition, you can reply to only the sender, or you can reply to everyone listed in the To and cc fields of the original message (reply to all).

Choose one of the following options:

- You can reply with no history.
- You can reply with history.
- You can reply to all with no history.
- You can reply to all with history.

To reply to a message

1. Select or open the message to which you want to reply.
2. Choose one of the following options:
   - To reply to the sender with no history, click **Reply > Reply** from the Action Bar button.
   - To reply to the sender with history, click **Reply > Reply with History** from the Action Bar button.
   - To reply to the sender and all other recipients with no history, click **Reply to All > Reply**.
   - To reply to the sender and all other recipients with history, click **Reply to All > Reply with History**.

   A new message displays with the **To**, **cc** and **Subject** fields already completed.
3. To add a voice message see [Recording voice messages](#) on page 31.
4. To add text or file attachments see [Adding text comments to voice messages](#) on page 32 and [Adding attachments to voice messages](#) on page 33.
5. To save or send the resulting message see [Sending voice messages](#) on page 33 and [Saving voice messages](#) on page 36.
Forwarding voice messages

You can forward any message in your Modular Messaging database to any user, provided Streaming is not enabled.

To forward a message:

1. Select or open the message you want to forward.
2. Click the Forward button on the Action Bar.
   
   A new message form displays with the Subject field already filled in. The message can be completed like any new message.

3. To address the message see Addressing voice messages on page 34.
4. To add a voice message see Recording voice messages on page 31.
5. To add text or file attachments see Adding text comments to voice messages on page 32 and Adding attachments to voice messages on page 33.
6. To save or send the resulting message see Sending voice messages on page 33 and Saving voice messages on page 36.
Managing messages

You can manage voice messages within the Modular Messaging database much like your normal Notes mail messages. You can save new messages before or after you send the message, you can delete your messages, you can edit the subject line of your messages, and you can copy or move your messages to local folders.

Saving voice messages

You can save your new voice messages before the message is sent, or you can choose to save the message when sending it.

Saving a voice message before sending

If you save a message before it is sent, it is stored in the Draft folder. You can then open the Drafts folder to find the saved message and open it to complete the message, and send it.

Saving a voice message when sending

When you send a message you have the option to save the message into the Sent folder. You can then open the Sent folder at a later time and open the message. You can then edit, resend or resave the message.

Note:

When you store messages in the Drafts or Sent folder they are stored within the local Modular Messaging database, and are not stored on the Modular Messaging Message Storage Sever.

Saving voice recordings, fax messages and other attachments to disk

Voice recordings, fax messages and other attachments are stored within voice messages as attachments. The Modular Message Notes Client displays a telephone icon 📞 to indicate a voice recording and a fax icon 📄 to indicate a fax message. Other attachments use a document icon 📄. These attachments are managed like any other Notes attachments which means that you can save the file to disk, copy and paste the attachment, or open the attachment using the default player for the computer.

Note:

If your administrator has enabled "Media Streaming", the body of the message displays each voice message using a gray telephone icon. You will not be able to copy or save these messages.
Deleting voice messages

You can delete voice messages from the Inbox folder or after opening the message.

Choose one of the following options to delete a message:

- Select the message from the Inbox folder and press **Delete**, or click the **Delete** Action Bar button.
- Open the message and click the **Delete** Action Bar button.

When a message is deleted, it is moved to the Trash folder. Messages are removed from the Trash folder based on the setting setup by the administrator on the Modular Messaging Message Storage Server.

Managing the Trash folder

If you open the Trash folder there are four options available. You can restore a deleted message, you can restore all deleted messages, you can remove a message from the Trash folder permanently or you can remove all messages from the Trash folder.

Choose one of the following options to manage your Trash folder.

- To restore a message select the message to be restored and click the **Restore** Action Bar button.
- To restore all messages click the **Restore All** Action Bar button.
- To delete a selected message click the **Delete Selected Item** Action Bar button.
- To remove all messages click the **Empty Trash** Action Bar button.

Editing Voice Messages

You can edit your messages to add information about the message that has been received. Editing a message that has been received is restricted to the Subject field only.

Choose one of the following options to edit a voice message:

- Select the message from a folder and press `<CTRL-E>` to put the document into edit mode.
- Open the message and press `<CTRL-E>` to put the document into edit mode.

Save the message. Your changes are reflected in the Modular Messaging database as well as on the MSS.

**Note:**

You can edit a message from any folder except the Trash folder. To edit a document that is currently in the Trash folder you must restore the document first.
Copying or moving voice messages

You can copy or move voice messages from any folder, except the Trash folder, to local folders. This provides a powerful method to organize large mailboxes.

Choose one of the following options to move a message:

- Select the message from any folder and click the **Folder > Move to Folder...** Action Bar button. Click the **Move** button on the Move to Folder dialog box.
- Click the mouse on a message from any folder and drag the message to a local folder.
- Open the message and click the **Folder > Move to Folder...** Action Bar button from within the message. Click the **Move** button on the Move to Folder dialog box.

Choose one of the following options to copy a message:

- Select the message from any folder and click the **Folder > Move to Folder...** Action Bar button. Click the **Add** button on the Move to Folder dialog box.
- Hold the `<CTRL>` key and click the mouse on a message from any folder and drag the message to a local folder.
- Open the message and click the **Folder > Move to Folder...** Action Bar button from within the message. Click the **Add** button on the Move to Folder dialog box.

**Note:**

When moving messages from the Inbox to a local folder, the message is removed from the MSS. The only copy of the message is now stored locally.

For more information on using local folders see [Folders (Local)] on page 27.

Synchronizing voice messages

You can synchronize voice messages from the Inbox folder or the All Documents view. Synchronizing voice messages from the MSS updates the messages with all information required so the messages can be reviewed in offline mode.

**Note:**

If a message has not been synchronized or opened previously it will not be available in offline mode.

Choose one of the following options to synchronize messages:

- To synchronize all messages in your Inbox folder or All Documents view, click the **Synchronize > All Messages** Action Bar button.
- To synchronize selected messages in your Inbox folder or All Documents view, select the messages in the view and click the **Synchronize > Selected Messages** Action Bar button.
Reference Information

Modular Messaging and Fax

Modular Messaging Notes Client allows you to send and receive fax messages just like your e-mail messages from within Lotus Notes. You can also fax a binary file such as a Microsoft Word document or a graphic file such as a gif or a jpeg by converting it into a Tagged Information File format (.tif file) and sending it as an e-mail attachment.

See Sending a Fax message on page 49 for more information on sending a fax using the Modular Messaging Notes Client.

You can also send a fax message through Modular Messaging without using the Modular Messaging Notes Client. See the Avaya Modular Messaging Native Fax Quick Start Guide for instructions.

Sending a Fax message

Use the following instructions to send a fax from within Lotus Notes using the Modular Messaging system.

1. Start Lotus Notes.
2. Open your Modular Messaging database and create a new e-mail message by clicking the New Memo Action Bar button.
3. In the To field on the New Message window, type fax=nnnn@mss.domain.com, where nnnn is the fax number of the recipient, and mss.domain.com is the Message Storage Server (MSS) and the domain name. Contact your system administrator for this information.
4. In the Subject field, type the desired text.
5. In the message body, type the desired text.
6. Click Send.

Once you send a fax, Modular Messaging sends a fax delivery status notification message (fax delivery successful or failed) to your Modular Messaging mailbox.

When you send a fax using the Modular Messaging system, the system automatically attaches a default cover page. You can edit the cover page details from the Fax settings in Modular Messaging. Contact your system administrator for more information.
You can also use Modular Messaging to fax a binary file such as a Word document or a graphic. You have to convert the binary file into a .tif file and send it as an e-mail attachment. Modular Messaging sends the attached .tif file as a fax. See the *Avaya Modular Messaging Native Fax Quick Start Guide* for instructions.

**Note:**
You can fax a binary file only if the binary file is a .tif file attachment to a fax message.

---

**Viewing and Printing a fax message**

Faxes in the Modular Messaging mailbox appear as e-mail messages with .tif attachments. You can view these files using the viewer built into Lotus Notes or by using the Windows image viewer such as Imaging for Windows or other TIFF viewers.

Right-click the .tif attachment, and either open it or save it to your computer.

After the fax image has been opened use the menu options within Imaging for Windows to view and print the fax message.

---

**Managing fax messages for TUI access**

You can handle fax messages using the TUI.

- You can access fax messages over the telephone using the options available from the telephone user interface (TUI). These options include forwarding a fax to another subscriber, or printing a fax message to a nearby fax machine, or deleting the fax message.

  **Note:**
  The options available for fax messages from the TUI depend on the specific telephone interface you are using.

- When you call into your Modular Messaging System over the telephone the number of new fax messages is played and you can choose to review your new fax messages. The system plays back the sender of the fax helping you decide what to do with the message.

- If you choose to print the fax the system prompts you for a fax number to send the fax message to.

For more information on handling fax messages using the TUI, see the TUI Guide.
Glossary

.WAV
A file extension used for Windows multimedia format audio data.

Action Bar
A row of buttons at the top of a folder, view or form within the Modular Messaging database.

Canonical Addressing
A method of addressing that specifies the full location, including country code and area code, in the following order:
+CountryCode [(AreaCode)] SubscriberNumber
For example, +1 (408) 345 800

Drafts folder
A folder in which new messages may be stored before they are sent.

Inbox folder
A folder in which you receive new messages.

mailbox
A delivery location for incoming voice, e-mail, and fax messages. The Modular Messaging database accesses messages from the mailbox located on the Message Storage Server.

Message Application Server
An Avaya Modular Messaging proprietary executable program that runs as a Windows NT/2000 Service and provides telephony services. The Message Application Server is also referred to as the MAS.

Message Storage Server
An Avaya Modular Messaging proprietary executable program that runs as a Linux application and provides message storage, messages, transport and directory services. The Message Storage Server is also referred to as the MSS.

Modular Messaging Database
A Lotus Notes database used to access messages stored in a mailbox on the Message Storage Server.

Modular Messaging Notes Client
A set of software components used to access a Modular Messaging mailbox from a Lotus Notes client.

multimedia
A PC has multimedia capabilities if it has a sound card, microphone, and speakers or headphones.

multipart message
A message that consists of several parts. Every time you forward a voice message or reply to a voice message including the original, a new part is added to the original message.

numeric address
A string of digits that uniquely identifies a recipient or a distribution list across the organization. A numeric address is used by the telephone user interface, and optionally by the Modular Messaging Notes Client, as a means of addressing a message.

password
Subscribers must enter their passwords to gain access to their mailbox through the telephone user interface, and through the Modular Messaging Notes Client. Subscribers can change their passwords using the telephone user interface or Subscriber Options.

PBX
See Private Branch Exchange (PBX).
playback controls

CD-type controls within the voice player/recorder with which you can play, pause, forward, and rewind messages.

Private Branch Exchange (PBX)

A telephone exchange local to a particular organization that uses, rather than provides, telephone services. Also known as a switch.

private message

Messages marked private. You can send private messages using the Modular Messaging Notes Client.

reply

A command that is used to reply to a message. The original message may be included in your reply.

Sent folder

A folder in your e-mail application that stores a copy of each message you sent.

subscriber

A user whose profile is enabled for voice messaging. A subscriber can use both the telephone user interface and the Modular Messaging Notes Client.

switch

See Private Branch Exchange (PBX).

telephone user interface (TUI)

An interface through which callers and subscribers can access their Modular Messaging mailbox through the telephone. The telephone user interface is also an automated attendant and voice messaging system that controls call handling. It greets incoming callers and instructs them on how to proceed.

text-to-speech (TTS)

The conversion of text into speech (speech synthesis). Subscribers can listen to their e-mail messages over the telephone using text-to-speech technology.

Trash folder

A folder that stores items that you have deleted. You can retrieve an item from the deleted items folder if the item has not yet been purged by the Message Storage Server.

TTS

See text-to-speech (TTS).

TUI

See Telephone user interface (TUI).

Subscriber Options

An application that allows subscribers to configure their mailboxes using their PCs. Subscribers can record all personal greetings and prompts, personalize their call handling options, and select whether to use multimedia or the telephone for recording and playing back voice messages.

Voice Memo Form

A Lotus Notes form within the Modular Messaging database used to create and review messages.

voice player/recorder

A software component that allows you to play and record messages within the Voice Memo Form.
# Index

## Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>.WAV file</td>
<td></td>
<td>51</td>
</tr>
</tbody>
</table>

## A

<table>
<thead>
<tr>
<th>Topic</th>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>action bar</td>
<td></td>
<td>24</td>
</tr>
<tr>
<td>adding attachments</td>
<td></td>
<td>33</td>
</tr>
<tr>
<td>adding text comments</td>
<td></td>
<td>32</td>
</tr>
<tr>
<td>addressing voice messages</td>
<td></td>
<td>34</td>
</tr>
<tr>
<td>all documents view</td>
<td></td>
<td>26</td>
</tr>
<tr>
<td>assigning priority</td>
<td></td>
<td>35</td>
</tr>
<tr>
<td>attachments</td>
<td></td>
<td>33</td>
</tr>
<tr>
<td>adding</td>
<td></td>
<td>33</td>
</tr>
<tr>
<td>detaching</td>
<td></td>
<td>45</td>
</tr>
<tr>
<td>viewing</td>
<td></td>
<td>42</td>
</tr>
<tr>
<td>Avaya Modular Messaging</td>
<td>definition</td>
<td>9</td>
</tr>
</tbody>
</table>

## B

<table>
<thead>
<tr>
<th>Topic</th>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>bookmark bar</td>
<td>adding bookmark</td>
<td>10</td>
</tr>
</tbody>
</table>

## C

<table>
<thead>
<tr>
<th>Topic</th>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>configuration</td>
<td></td>
<td>19</td>
</tr>
<tr>
<td>controls</td>
<td></td>
<td>39</td>
</tr>
<tr>
<td>playback</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>conventions</td>
<td></td>
<td>47</td>
</tr>
<tr>
<td>copying voice messages</td>
<td></td>
<td>31</td>
</tr>
</tbody>
</table>

## D

<table>
<thead>
<tr>
<th>Topic</th>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>deleted messages</td>
<td></td>
<td>46</td>
</tr>
<tr>
<td>purging</td>
<td></td>
<td>46</td>
</tr>
<tr>
<td>restoring</td>
<td></td>
<td>46</td>
</tr>
<tr>
<td>deleting trash</td>
<td></td>
<td>46</td>
</tr>
<tr>
<td>deleting voice messages</td>
<td></td>
<td>46</td>
</tr>
<tr>
<td>delivery options</td>
<td></td>
<td>35</td>
</tr>
<tr>
<td>document conventions</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>draft view</td>
<td></td>
<td>25</td>
</tr>
<tr>
<td>drafts folder</td>
<td>definition</td>
<td>51</td>
</tr>
</tbody>
</table>

## E

<table>
<thead>
<tr>
<th>Topic</th>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>editing voice messages</td>
<td></td>
<td>46</td>
</tr>
<tr>
<td>emptying the trash</td>
<td></td>
<td>26, 46</td>
</tr>
</tbody>
</table>

## F

<table>
<thead>
<tr>
<th>Topic</th>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>fax messages viewing</td>
<td></td>
<td>42</td>
</tr>
<tr>
<td>folders</td>
<td></td>
<td></td>
</tr>
<tr>
<td>all documents</td>
<td></td>
<td>26</td>
</tr>
<tr>
<td>drafts</td>
<td></td>
<td>25</td>
</tr>
<tr>
<td>inbox</td>
<td></td>
<td>23</td>
</tr>
<tr>
<td>local</td>
<td></td>
<td>27</td>
</tr>
<tr>
<td>sent</td>
<td></td>
<td>26</td>
</tr>
<tr>
<td>trash</td>
<td></td>
<td>26</td>
</tr>
<tr>
<td>forwarding voice messages</td>
<td></td>
<td>44</td>
</tr>
</tbody>
</table>

## G

<table>
<thead>
<tr>
<th>Topic</th>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glossary</td>
<td></td>
<td>51</td>
</tr>
</tbody>
</table>

## H

<table>
<thead>
<tr>
<th>Topic</th>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>hardware requirements</td>
<td></td>
<td>16</td>
</tr>
</tbody>
</table>

## I

<table>
<thead>
<tr>
<th>Topic</th>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inbox</td>
<td>definition</td>
<td>11</td>
</tr>
<tr>
<td>inbox folder</td>
<td></td>
<td>23, 38</td>
</tr>
<tr>
<td>installation</td>
<td></td>
<td>51</td>
</tr>
<tr>
<td>uninstalling</td>
<td></td>
<td>17</td>
</tr>
<tr>
<td>upgrading</td>
<td></td>
<td>18</td>
</tr>
</tbody>
</table>

## L

<table>
<thead>
<tr>
<th>Topic</th>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>listening to voice messages</td>
<td></td>
<td>39</td>
</tr>
<tr>
<td>local folders</td>
<td></td>
<td>27</td>
</tr>
</tbody>
</table>

## M

<table>
<thead>
<tr>
<th>Topic</th>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>mailbox</td>
<td>definition</td>
<td>51</td>
</tr>
<tr>
<td>managing fax messages</td>
<td></td>
<td>50</td>
</tr>
<tr>
<td>managing trash</td>
<td></td>
<td>46</td>
</tr>
</tbody>
</table>
### Index

MAS See Message Application Server

Message Application Server (MAS)
- definition ........................................... 51
- prerequisites ........................................ 20

Message Storage Server (MSS)
- definition ........................................... 51
- prerequisites ........................................ 19

Modular Messaging
- definition ........................................... 9

Modular Messaging Database
- configuring ......................................... 21
- creating ........................................... 21
- definition ........................................... 51
- preferences ......................................... 27
- upgrading .......................................... 22

Modular Messaging Notes Client
- definition ........................................... 51
- moving voice messages .............................. 47

MSS See Message Storage Server

multimedia
- definition ........................................... 51
- multipart message
  - definition ........................................... 51
  - multipart voice messages ......................... 41

N
- navigating voice messages ......................... 40
- numeric address
  - definition ........................................... 51

O
- opening a message ................................... 23

P
- password
  - definition ........................................... 51
- PBX See also private branch exchange
  - definition ........................................... 52
- playback controls
  - definition ........................................... 52
- preferences ......................................... 27
- priority ............................................ 35
- private
  - setting ............................................ 35
- private branch exchange (PBX)
  - definition ........................................... 52
- private message
  - definition ........................................... 52
- purging deleted messages ......................... 26, 46

R
- record controls
  - definition ........................................... 52
- recording voice messages ........................... 31
- reply
  - definition ........................................... 52
- replying to voice messages
  - voice messages
    - replying ........................................... 43
- requirements ........................................ 16
- restoring deleted messages ....................... 26, 46
- reviewing voice messages ........................... 39

S
- saving attachments ................................... 45
- saving voice messages ............................... 36, 45
- send options ........................................ 35
- sending a fax message ................................ 49
- sending voice messages ............................... 33, 36
- sent folder
  - definition ........................................... 52
- sent view ............................................ 26
- setting private option ................................ 35
- software
  - installation ........................................ 17
- requirements ........................................ 16
- uninstall ............................................ 18
- software upgrade .................................... 18
- subscriber
  - definition ........................................... 52
- Subscriber Options
  - definition ........................................... 13
- subscriber options ................................... 28
- initializing ......................................... 20
- switch
  - definition ........................................... 52
- synchronizing voice messages ...................... 47

T
- telephone user interface (TUI)
  - definition ........................................... 52
- text comments
  - adding ............................................. 32
- text messages
  - viewing ............................................. 41
- text-to-speech (TTS)
  - definition ........................................... 52
- trash folder .......................................... 26, 46
  - definition ........................................... 52

TTS
### Index

<table>
<thead>
<tr>
<th>Definition</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>TUI definition</td>
<td>52</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>U</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>uninstalling</td>
<td>18</td>
</tr>
<tr>
<td>unread marks</td>
<td>11</td>
</tr>
<tr>
<td>upgrading</td>
<td>18, 22</td>
</tr>
<tr>
<td>urgent</td>
<td>35</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>V</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>viewing a fax message</td>
<td>50</td>
</tr>
<tr>
<td>viewing attachments</td>
<td>42</td>
</tr>
<tr>
<td>viewing fax messages</td>
<td>42</td>
</tr>
<tr>
<td>viewing text messages</td>
<td>41</td>
</tr>
<tr>
<td>views</td>
<td></td>
</tr>
<tr>
<td>all documents</td>
<td>26</td>
</tr>
<tr>
<td>drafts</td>
<td>25</td>
</tr>
<tr>
<td>inbox</td>
<td>23</td>
</tr>
<tr>
<td>sent</td>
<td>26</td>
</tr>
<tr>
<td>trash</td>
<td>26</td>
</tr>
<tr>
<td>Voice Memo Form</td>
<td></td>
</tr>
<tr>
<td>definition</td>
<td>11</td>
</tr>
<tr>
<td>voice memo form</td>
<td></td>
</tr>
<tr>
<td>definition</td>
<td>52</td>
</tr>
<tr>
<td>voice messages</td>
<td></td>
</tr>
<tr>
<td>addressing</td>
<td>34</td>
</tr>
<tr>
<td>copying</td>
<td>47</td>
</tr>
<tr>
<td>creating</td>
<td>31</td>
</tr>
<tr>
<td>deleting</td>
<td>46</td>
</tr>
<tr>
<td>editing</td>
<td>46</td>
</tr>
<tr>
<td>forwarding</td>
<td>44</td>
</tr>
<tr>
<td>listening</td>
<td>39</td>
</tr>
<tr>
<td>moving</td>
<td>47</td>
</tr>
<tr>
<td>multipart</td>
<td>41</td>
</tr>
<tr>
<td>navigating</td>
<td>40</td>
</tr>
<tr>
<td>opening</td>
<td>23</td>
</tr>
<tr>
<td>recording</td>
<td>31</td>
</tr>
<tr>
<td>reviewing</td>
<td>39</td>
</tr>
<tr>
<td>saving</td>
<td>36, 45</td>
</tr>
<tr>
<td>sending</td>
<td>33, 36</td>
</tr>
<tr>
<td>synchronizing</td>
<td>47</td>
</tr>
<tr>
<td>voice player/recorder</td>
<td>39</td>
</tr>
<tr>
<td>definition</td>
<td>52</td>
</tr>
</tbody>
</table>